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Contact Information

After using this guide to configure your shop equipment, you should have a good impression of  how the tools 
can be used to improve your shop efficiency. However, if  you have questions about SignLab for VersaWorks, 
then please contact either your assigned dealer, or CADlink directly.

Internet

www.cadlink.com
www.signlab.com

E-mail

sales@cadlink.com

United States

500 Main Street
Clinton, MA 01510
Tel: 1-800-545-9581
Fax: (613) 247-1488

Canada

2150 Thurston Drive
Ottawa, ON K1G 5T9
Tel: (613) 247-0850
Fax: (613) 247-1488

Europe

Intech House, Wilbury Way
Hitchin, Herts, U.K. SG4 0TW
Tel: ++44(0) 1462-420222
Fax: ++44(0) 1462-420111

Germany

Georg Christoph Neller Str. 3
D-54296 Trier
Tel.: +49 (651) 96644840
Fax.: +49 (651) 96644841
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Limited Warranty on CADlink Products 
CADlink warrants that the disk medium upon which the product is recorded, and any hardware accompanying 
said disk(s), shall be free from defects in materials and workmanship -- under normal use and service for a 
period of  ninety (90) days from the date of  delivery, as evidenced by a copy of  the receipt.
CADlink’s entire liability and exclusive remedy as to the disk(s) or hardware shall be at CADlink’s option 
-- either (a) return of  the purchase price, or (b) replacement of  the disk(s) or hardware that do not meet 
CADlink’s Limited Warranty. These must be returned to CADlink postage pre-paid with a copy of  the receipt.
If  failure of  the disk(s) or hardware has resulted from accident, abuse or misapplication, CADlink shall have 
no responsibility to replace the disk(s) or hardware, the replacement will be warranted for the remainder of  the 
original warranty period or thirty (30) days, whichever is longer. Other then the above limited warranty, CADlink 
makes no other warranties whatsoever, either legal or conventional, express or implied, with respect to the 
licensed software and hardware. You are advised to test the licensed software thoroughly before relying on it. 
You assume the entire risk of  using the licensed software. Because of  the diversity of  conditions and hardware 
under which the licensed software may be used, no warranty of  merchantability or fitness for a particular 
purpose is given. Some regions do not allow the exclusion of  implied warranties, so the above exclusion may 
not apply.

Copyright Notice

PANTONE® Colors displayed in the software application or in the user documentation may not match 
PANTONE-identified standards. Consult current PANTONE Color Publications for accurate color. 
PANTONE® and other Pantone, Inc. trademarks are the property of  Pantone, Inc., 2010.
Pantone, Inc. is the copyright owner of  color data and/or software which are licensed to CADlink Technology 
Corp. to distribute for use only in combination with SignLab. PANTONE Color Data and/or Software shall 
not be copied onto another disk or into memory unless as part of  the execution of  SignLab and/or Visual 
Production Manager.
No part of  this publication may be reproduced mechanically or electronically or in any form without the 
prior written permission of  CADlink. The software described in this manual is furnished under license and 
may only be used or copied in accordance with the terms of  such license. The information in this manual is 
for informational use only, is subject to change without notice and should not be construed as a commitment 
by CADlink. CADlink assumes no responsibility or liability for any errors or inaccuracies that may appear in 
this document. SignLab®, SignLab Vinyl®, SignLab Print and Cut®, SignLab Vinyl Pro®, Visual Production 
Manager®, Visual Print Manager®, and Digital Factory® are registered trademarks of  CADlink Technology 
Corporation.

Written and designed at CADlink Technology Corporation
2150 Thurston Drive, Ottawa, ON, Canada, K1G 5T9
Phone (613) 247-0850
Fax (613) 247-1488
Manual & Package Design by CADlink Marketing and Customer Support.
Printed in Canada. Product of  Canada.
© September 2011, CADlink Technology Corporation
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Installing SignLab
Your SignLab for VersaWorks package is provided with an orange USB security dongle to prevent unauthorized 
use or pirating of  the software. This dongle is a flash drive that plugs into a standard USB port of  the computer, 
and it is transparent to other applications. Only SignLab is aware of  the device.

Policy On Lost Or Stolen Dongles
□□ The USB dongle provided with SignLab is your proof  of  purchase. If  the dongle is lost or stolen, then that 

is equivalent to losing the entire software package, and a new package of  SignLab must be purchased.
□□ In the event of  a damaged dongle that must be replaced, there is a nominal fee for EXCHANGING a new 

dongle for the older dongle, where the older dongle must be reclaimed by CADlink.
This fee is waived where product is still under warranty.

□□ Regardless, it is recommended that you ensure that your dongle is covered under your business insurance 
policy.

Temporary License Files
□□ License files are included with your USB dongle, which are used to confirm the features within your 

CADlink products.
□□ If  a replacement dongle is being shipped to you, then you will typically be issued “temporary” license files 

that will enable you to continue using your CADlink products.
□□ Temporary license files will cease working after a set criteria, though the expectation is that your 

replacement dongle will arrive prior to expiry.
□□ Please note that the replacement dongle will be provided with new “permanent” license files that will 

replace the temporary license files.

Storing Your License Files
□□ In the event of  lost license files, there is a nominal administrative fee for issuing replacement license files.

The fee is waived if the Free Support period is still active. Otherwise, replacement license file issues are treated 
like Tech Support requests.

□□ When CADlink sends you new license files, it is important that you create backups of  the license files, so 
they can be easily located when re-installing your CADlink products on new equipment.

□□ In the case of  the orange USB flash drive dongle, your license files can be stored on the dongle itself. When 
re-installing your CADlink products, license files upon the dongle will be automatically used.

Connect your orange dongle BEFORE 
installing your SignLab software!

Note: The dongle is not required for Trial 
versions of  SignLab for VersaWorks.
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Print&Cut

Part 1 - Program Installation

The following steps are an overview of  installing SignLab for VersaWorks, and further information is provided 
within each stage of  the install wizard.
1.	 Connect the orange USB dongle to your computer.

Note: The dongle is not required for Trial versions of  SignLab for VersaWorks.

2.	 Insert the SignLab for VersaWorks CD into your CD-ROM drive. The install wizard should “auto start”.

If  the install wizard fails to auto start, then start the installation process manually:
a)	 From the Start menu, choose Run to open the Run dialog.
b)	 Click Browse and locate the setup.exe file that is on the CD in the CD-ROM drive.
c)	 Click Open to choose the setup.exe file, and click OK to close the Run dialog.

3.	 Proceed with each stage of  the install wizard. Instructions are provided at each stage.
4.	 When the install wizard is complete, proceed to “Part 2 - Launching SignLab”.

Part 2 - Launching SignLab

At this point, you are ready to launch SignLab and output a print and/or cut job. This will confirm that your 
software and hardware are communicating as expected.
5.	 From the Windows Start menu, launch SignLab.
6.	 When you launch SignLab for the first time, a Browse for Folder dialog will ask you to identify the 

VersaWorks installation directory. Once this has been done, SignLab will be configured to use the color 
profiles that are set within your VersaWorks, thereby providing you with the necessary color matching for 
your media and inks.

7.	 Proceed to “Part 3 - Test Output from SignLab to VersaWorks”.

Part 3 - Test Output from SignLab to VersaWorks

When a print and/or cut job is sent from SignLab to VersaWorks, a special cut path name is used to tag cut 
paths within the job file. By default, the cut path name is set as “CutContour” when SignLab is installed. 
However, if  you have changed the default cut path name within VersaWorks, then you will need to tell SignLab 
to use the correct cut path name when outputting to VersaWorks.
If  you wish to complete a print-only job, then skip the steps in gray.
8.	 In SignLab, prepare a job that will be used to test output to VersaWorks.

9.	 Choose Options menu >> SignLab Setup >> PostScript Setup.
10.	The PostScript dialog will open (Fig. 1).
11.	By default, “CutContour” is the name that VersaWorks uses to recognize cut paths in jobs that are received 

from SignLab.

12.	On the SignLab workspace, import or create your design.
13.	Choose File menu >> Print to Roland VersaWorks.
14.	When prompted, choose whether the job should go to Queue A or Queue B.

The job will now be received by VersaWorks.
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Introduction

SignLab for VersaWorks provides you with high-end layout production 
tools for preparing and sending your jobs to VersaWorks. SignLab 
is Computer Aided Design (CAD) software for signmakers, which 
provides leading edge technologies as an all-in-one package for efficient 
sign shop operation. Development for SignLab is an ongoing process, 
where new technologies and tools are incorporated into SignLab to 
support modern sign shop needs. Despite the pressure to add new 
features, radical changes to the user interfaces and workflows are 
avoided, so that signmakers are not inconvenienced when upgrading to 
the latest SignLab.
SignLab tools are simple and versatile for designing with text, line art, 
and images (i.e., bitmaps). SignLab also provides significant support for 
other design applications, so that unfinished or archived designs can be 
brought into SignLab for pre-production work.

Understanding the Difference Between Print Versus Print&Cut

If  you are new to SignLab, then the following points will summarize 
how to use the SignLab controls.

Printing versus Print&Cut
□□ Both “print only” and “print and cut” jobs can be processed 

through the Print to Roland VersaWorks command.

□□ A “print and cut” job is like a regular print job, except that contour cut paths are applied after the print 
portion of  the job. For example, stickers are commonly created through a “print and cut” process.

□□ Though the File menu >> Print command is available in SignLab, it is typically used for printing simple 
drafts or customer proofs to a desktop printer, whereas large format printing should be performed through 
the Print to Roland VersaWorks command.

Contour Cutting versus Print&Cut
□□ When using the Print to Roland VersaWorks command, all workspace shapes are considered to be print-

only objects, except contour cut paths that represent cut-only objects.
□□ Cut paths are created using the Cut menu tools, such as Contour Cut, Contour Cut On/Off, or Die Cut.

VersaWorks
□□ The Print to Roland VersaWorks command will process jobs through your VersaWorks RIP software 

(either queue A or B).
□□ Your VersaWorks software should be launched prior to sending the job from SignLab, rather than rely upon 

Windows to launch VersaWorks automatically.

Choosing Registration Marks and Alignment Systems

SignLab provides support for an extensive variety of  printers and cutters, both in terms of  manufacturers and 
machine models. However, the technology used for printer-cutter alignment varies, such as the following:

□□ Hybrid printers that automatically align cut operations after completing the print job.
□□ Printers that automatically print registration marks that will be used for cut alignment.
□□ For print-laminate-cut jobs, where the printed job will be laminated and loaded back into the hybrid printer 

for cutting, the printer will typically print the registration marks that it needs for cut alignment. 

Fig. 1� - When printing a job, 
a PostScript file is sent to the 
VersaWorks RIP software. 
To ensure that VersaWorks 
recognizes cut paths, confirm 
the name used to identify cut 
paths in the PostScript file.
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□□ Cutters that have optical eye systems (i.e., a laser) that can automatically align to specific types of  registration 
marks.

□□ Cutters that do not have optical eye systems, which require that the operator visually position the cutting 
tool according to the registration marks. In such cases, it is recommended that Three point automatic 
registration marks be created (if  available).

□□ For cut vinyl applications, cutting registration marks that are used to visually align multiple layers of  color 
vinyl.

When configuring your printer and/or cutter, it is important to consider both the job application, and the 
choices of  printer/cutter alignment that are detailed within the Operator Manuals of  the given machines.
Depending upon the type of  work being performed, it may be necessary to manually add registration marks 
within SignLab.

Registration Marks in SignLab

□□ In SignLab, choose Shapes Tools >> Registration Mark to manually place individual registration marks.
□□ Likewise, choose Shapes Tools >> Multi-Registration Mark to place sets of  registration marks.
□□ These tools are typically used for cut vinyl applications, though they can be equally applicable for print&cut 

applications, provided that the marks are placed according to the Operator Manual guidelines.
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Feature Highlights for SignLab

The following sections highlight key features and functionality that have been added as of  SignLab 9:
□□ Image and Color Support

□□ Transparency (Opacity) Support

□□ Send to SignLab Plug-ins

□□ Contour Path Plug-in for CorelDraw

□□ Import/Export Files

□□ Power Tools

□□ General Feature Improvements
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Image and Color Support

□□ CMYK Color Management - Expanded on-screen color management now includes the display of  imported CMYK 
images, which avoids the potential for color shifts between RGB and CMYK color spaces.

□□ CMYK Color Mode - Likewise, images created within SignLab can be set as CMYK color mode, which expands 
upon the previous RGB, Grayscale, Indexed Color and Monochrome modes.

□□ CMYK Gradient Fills - In addition to previous gradient fill tools, new gradient fills have been introduced for specific 
use with CMYK colors.

□□ Optimized Memory Handling - Though not an explicit feature, the underlying code within SignLab has been 
significantly optimized with respect to previous versions, such that manipulation of  large images should be noticeably 
improved.

□□ Publish PDF with Color Matching - When publishing your design as a PDF proof, you can now specify whether 
the PDF is for on-screen display, or for a printed proof. This will ensure that the customer sees the expected design 
colors.

Transparency (Opacity) Support

□□ Transparency Support - For imported design files that contain an alpha channel (i.e., a transparency layer), SignLab 
can preserve the transparency.

□□ Extended Transparency Tools - These tools are provided for easy transparency adjustments, such as “make lighter,” 
“make darker,” or automatically knocking out a white background.

□□ Primer and Highlight Conversion - Alternatively, if  an imported file contains an alpha channel, then SignLab can 
convert it into primer and highlight settings (as used with spot white color printing).

□□ Transparency Gradient Fills - These fills create gradient effects that allow the underlying objects to “show through” 
(Fig. 2).

□□ Improved Fluid Mask Support - With the introduction of  transparency support in SignLab, this enables you to 
make full use of  the Fluid Mask Blend tool when working with difficult foreground subjects, like hair. Resulting 
images can be positioned with new backgrounds, and the hair regions will blend naturally (Fig. 3).

Note: Fluid Mask is an optional add-in that might already be included with your package.

Fig. 2� - In this transparency example, a black rectangle 
is applied with linear transparency, with the handles 
adjusted to create a dark band at the left. When 
combined with an image, this creates a black sidebar 
where text can remain visible against the background.

Fig. 3� - On the right is a stock photo of a feather 
against a black background. On the left, FluidMask 
has knocked out the black background, and 
the resulting image has been placed above a 
yellow oval shape. Notice how the Blend tool 
works in conjunction with transparency in 
SignLab to retain the ruffled details of the feather 
(particularly at the bottom left).
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Send to SignLab Plug-in (CorelDraw)
For CorelDraw X3 and later, the Send to SignLab button (Fig. 4) provides an easy means of  transferring your CorelDraw 
design to SignLab, which can be further modified (e.g., contour cut, specialty colors, transparency work, etc.) before output 
for production.
There are three types of  image data that can be used when sending a design to SignLab. The choice of  image data is 
situational, per the design parameters.

□□ PDF - This is often the best choice for maintaining colors as shown in the original CorelDraw design.
□□ EPS - This is the best choice for designs that contain transparency data, such as shadow effects. In SignLab, the EPS 

Options dialog (Fig. 5) will provide further options.
□□ PSD - This option will effectively convert the design to bitmap data, which can be a useful alternative if  there are 

issues with using PDF or EPS.

Fig. 4� - In CorelDraw X3 and later, click the Send to 
SignLab button to send your design as either PSD, 
PDF or EPS data, per your job requirements.

Fig. 5� - When sending EPS data, SignLab will 
provide further options as to how the data 
should be interpreted. For best results, import 
the data as PDF.
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Send to SignLab Plug-in (Illustrator)
For Illustrator CS and later, the File menu >> Send to SignLab command is available (Fig. 6), and a palette can be 
accessed via Windows menu >> Send to SignLab.
There are three types of  image data that can be used when sending a design to SignLab. The choice of  image data is 
situational, per the design parameters.

□□ PDF - This is often the best choice for maintaining colors as shown in the original Illustrator design.
□□ EPS - This is the best choice for designs that contain transparency data, such as shadow effects. In SignLab, the EPS 

Options dialog will provide further options.
□□ PSD - This option will effectively convert the design to bitmap data, which can be a useful alternative if  there are 

issues with using PDF or EPS.

Send to SignLab Plug-in (PhotoShop)
For PhotoShop CS and later, the File menu >> Automate >> Send to SignLab command is available (Fig. 7). The 
PhotoShop design will be sent to SignLab as bitmap data, which can then be further modified (e.g., contour cut) before 
output for production.

Fig. 7� - In PhotoShop (version CS and later), use the “Send 
to” plug-ins that are under File menu >> Automate.

Fig. 6� - In Illustrator (version CS and later), either 
use the “Send to” plug-ins that are under the 
File menu, or access palette controls under the 
Windows menu.
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Contour Path Plug-in for CorelDraw

The CADlink Contour Path (Fig. 8) button is an aid for CorelDraw users that need a convenient means of  defining a 
contour path that encloses the given design. When the design is brought into either SignLab or VPM, the contour path 
can be converted into a cut path, which will then be processed as part of  a print&cut job.
There are two aspects to the Contour Path plug-in:

□□ Using the Add contour path option, create contour paths based upon the current selection. Paths can be created for 
both the inner and outer contours of  objects.

□□ After two-or-more contour paths have been created, use the Perform basic weld option to combine them. 
Overlapping paths will be welded to form contiguous paths.

Import/Export Files

□□ Import and Export Filters - Ongoing improvement of  import and export filters now includes import of  PhotoShop 
(PSD) files.

□□ Contour Cut Paths in Linked EPS and PDF Files - When linking either an EPS or PDF file into a SignLab design, 
CMYK or RGB colors can be automatically converted into contour cut or halfcut paths.

Fig. 8� - The CADlink Contour Path plug-in provides 
two functions: 1) create contour paths for your 
design elements, and 2) weld two-or-more contour 
paths into a combined path.
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Power Tools

□□ Easy Menu Board Creation - As part of  the new Text Compose interface, interactive tools have been introduced for 
constructing menu boards, where individual menu sections (Fig. 9) can be placed and resized with ease.

□□ Spiral Shape Tool - In addition to the existing collection of  basic shape tools, spiral shapes can now be created. Like 
other parametric objects, on-screen handles can be used to customize the spiral appearance.

□□ Total Area Calculation Tool - For costing car wraps, select one-or-more objects that represent the physical area that 
will be wrapped (e.g., car doors, hood, etc. from a vehicle template), and then perform the area calculation.

General Feature Improvements

□□ Text Toolbox in Text Compose - The Text Compose interface has been improved by grouping features into tabs of  
the Text Toolbox (Fig. 10).

□□ Character Picker - For unusual characters that are difficult to reproduce with a standard keyboard arrangement, use 
the character picker in Text Compose mode to display and select a desired character.

□□ Custom Sign Blank - As opposed to a simple rectangular sign blank, set a custom sign blank (Fig. 49) that has 
unusual shapes or contours, such as garments, novelty items, bus windows, or non-rectangular can shapes (e.g., 
McDonald’s ‘ M ’ ).

Fig. 9� - A menu section with price columns.  Dot leaders can be added for 
readability, and price can be automatically aligned to the decimal point.

Fig. 10� - Set a custom sign 
blank shape according 
to the area and shape of 
the material (in this case a 
T-shirt design).
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□□ Lasso Select - As opposed to making selections with a rectangular selection marquee, you can freehand draw an 
irregular region that will select all of  the enclosed objects.

□□ Optimized Contour Cut and Vectorization - The underlying algorithms for generating contour paths and 
vectorization of  images have been optimized, such that previously large jobs can now be completed in a fraction of  
the time.

□□ Job Notes Lookup - A new search feature has been introduced for browsing and inspecting customer information 
and job history.

□□ New Plug-ins - The collection of  SignLab plug-ins have been expanded with more CADlink and third-party plug-
ins.

□□ Dotted Line for Strokes - Create dashed (and dotted) lines that have a specific dash length and space between dashes 
(Fig. 11).

□□ Multiple Stroke Colors - As opposed to having a solid stroke color, strokes can be composed of  a blend between 
two distinct colors.

Fig. 11� - Both dash and gap 
length can be quickly applied as 
part of a line style.
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Creating Cut Paths in SignLab

SignLab shapes are generally considered to be print-only objects, except when cut paths have been created using 
the Cut menu tools. Through a variety of  means, a print object can either have cut paths applied to its contour, 
or the object can be converted into a cut path (in effect replacing the original print-only object). Unlike other 
graphics programs, SignLab is designed to work with print and cut work flows using cut objects, as opposed to 
using a special color to designate print objects as cut paths. The following workflows show how cut paths can be 
created:

Recognizing Cut Paths in VersaWorks

When a print and/or cut job is sent from SignLab to VersaWorks, a special cut path name is used to tag cut 
paths within the job file. By default, the cut path name is set as “CutContour” when SignLab for VersaWorks is 
installed. However, if  you have changed the default cut path name within VersaWorks, then you will need to tell 
SignLab to use the correct cut path name when outputting to VersaWorks.

1.	 From the SignLab Options menu, choose SignLab Setup >> PostScript Setup.
2.	 The PostScript dialog will open.
3.	 By default, the edit field will indicate “CutContour” as the name that VersaWorks will use to identify cut 

paths in jobs that are received from SignLab.

Adding Cut Paths to Line Art

1.	 Select the line art for which cut paths will be added.
2.	 From the Cut menu, choose Contour Cut.
3.	 At the far-left of  the SmartBar, select the type of  cut path that you want to create.

For example, tick the Inside/Outside checkbox to apply the cut path to both the inner and outer contours 
of  the line art.

4.	 Set the Corner Style according to how rounded or sharp the cut paths should be (Fig. 12).

Fig. 12� - There are three possible corner styles when creating cut paths.

Point Corner: Trace all corners to a 
sharp point

Round Corner: Soften the corners 
to a rounded edge

Miter Corner: Crop or square the 
corners
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5.	 Set the Offset according to how closely the cut path should follow the object contour. An Offset of  zero 
will cut flush with the object contour (Fig. 13).

6.	 For the Miter corner style, the Miter Limit field will appear in the SmartBar. The Miter Limit is applied 
between the corners of  the original object and the cut path. This limit is expressed as a percentage of  the 
Offset amount (Fig. 14).

7.	 The Color Picker is used to indicate the color of  the dashed cut paths on the workspace. Select a color that 
is not already in use in the graphic, so you can distinguish cut paths from other objects.

8.	 If  desired, increase the Bleed Amount, such that the print objects slightly overlap the cut paths (Fig. 15).
9.	 Click an empty portion of  the workspace to finish editing the cut paths.

The cut paths will appear as dashed lines along the contour of  the line art.

Fig. 13� - The cut path can be flush with the object, or offset either away or towards the object.

Offset 0 Offset +1 Offset -1

Fig. 14� - When a miter limit is set, sharp corners 
are clipped at a percentage of the offset amount.

Fig. 15� - Bleeding causes the objects to become slightly larger, 
such that they are trimmed by the cut paths. This prevents 
registration errors from revealing the media color.



18SignLab for VersaWorks Quick Start Creating Cut Paths in SignLab

Adding Cut Borders with Half Cut
Cut menu >> Contour Cut (regular cut paths)

Cut menu >> Half  Cut (additional cut paths to create a border for handling)

The Half  Cut feature is used to create contour cut decals that have an additional half  cut border around the 
decal. The border is used for handling the decal, and an optional peel tab can be added to improve the ease of  
peeling (Fig. 16). The resulting decals would be appropriate for retail consumers as a novelty or promotional 
sticker.

Creating the Half Cut

1.	 Suppose that you have applied cut paths to a design, and a half  cut path needed to be added.
2.	 Select both the design and the cut paths.
3.	 Choose Cut menu >> Half  Cut
4.	 The Half  Cut path will be previewed on the workspace as dashed lines, with dashes that are slightly longer 

than those of  the cut paths.
5.	 From the SmartBar, set the Offset (i.e., border thickness) that will be created around the cut paths.
6.	 Click an empty portion of  the workspace to finish editing.
7.	 In the Sheet Layer palette (View menu >> Palettes), double-click the Layer 1 plate.
8.	 In the Sheet Layer dialog, click Add.
9.	 A Layer 2 plate will be created in the Sheet Layer palette.
10.	Select the Half  Cut path that you previously created.
11.	Click the Layer 2 plate, and the Half  Cut path will be moved to the Layer 2 plate.

Fig. 16� - Create a contour cut first, then create a half cut 
that represents  the extra margin for handling the decal.
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Output the Print and Cut Portion

12.	Press [Ctrl] and then click the Layer 2 plate.
13.	The Layer 2 plate will appear grayed out, and the half  cut path will be hidden.
14.	Choose File menu >> Print to VersaWorks.
15.	For a frame of  reference, it is recommended that the Edge of  sign blank option be enabled.
16.	Proceed with output of  the print and cut job.

Output the Half Cut Portion

17.	Back in SignLab, [Ctrl + click] to activate the Layer 2 plate.
18.	Then [Ctrl + click] the Layer 1 plate.
19.	Only the half  cut path should be visible now.
20.	Choose File menu >> Print to VersaWorks, and again output with the Edge of  sign blank option be 

enabled.
21.	On the Cutting Options tab, set the Half  Cuts drop-list.

Converting Line Art into Cut Paths

1.	 Select the imported line art that you want to convert to a cut path.
2.	 From the Cut menu, choose Contour Cut On/Off. The line art shape is now displayed as a series of  

dashed lines to indicate that it is a cut path (Fig. 17).

Note that the cut path color will be the same as the original line art fill color. This color does not matter unless 
you wish to use the Filter By Color tool, in which case this allows you to send cut jobs according to cut path 
color.
To convert a cut path back to the original line art, select Cut >> Contour Cut On/Off. However, note that any 
strokes that had been applied to the original line art will have been discarded.

Fig. 17� - Dashed lines indicate cut paths.
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Creating Geometric Die Cut Shapes

To create a geometric cut path that is centered on an image, use the Cut >> Die Cut command. Use the Die 
Style drop-list to create a tool path based on preset shapes. For example, you would use this tool to make a cut 
around a photo.
1.	 Select the image that you want to add a geometric cut path to.
2.	 From the Cut menu, choose Die Cut. 
3.	 At the far-left of  the SmartBar is a drop-list for Die Style that is used to choose the geometric pattern. The 

available styles are:
□□ Square
□□ Rectangle
□□ Circle
□□ Oval
□□ Triangle
□□ Polygon
□□ Star
□□ Pointed Gear
□□ Blunt Gear

4.	 Select a die style from the drop-list. The die cut shape will be centered on the image, and the die cut lines 
will be dashed to indicate that they are cut paths (Fig. 18).

5.	 Select a color for the dashed cut paths using the Color Picker. The color does not matter unless you wish 
to use the Filter By Color tool, in which case this allows you send cut jobs according to cut path color.

6.	 The remainder of  the SmartBar parameters will depend upon the type of  geometric pattern that has been 
selected for the die cut. Where applicable, these parameters are used to set the height, width, rotation, 
number of  sides, etc.

7.	 Click Apply to finish editing the die cut.

Fig. 18� - A scanned photo with an oval die cut.
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Cutting by Color

For cut-only jobs in SignLab, the SignLab Vinyl and SignLab Print and Cut packages have a Cut by Color 
feature that allows you to output cut paths according to their “fill” color. However, the Cut by Color feature is not 
available in the SignLab for VersaWorks product. Instead, use the following procedure for cutting by color to 
VersaWorks:

1.	 Import or create the given design on the SignLab workspace.
2.	 Assign different fill colors according to how shapes should be grouped when cutting.

For example, assign a red fill for shapes that should be part of  the first cut job, blue for the second cut job, 
green for the third cut job, and so on. 

3.	 In the Shop Palette, make note of  the colors that have been assigned.
4.	 From the Edit menu, choose Select All.
5.	 From the Cut menu, choose Contour Cut On/Off.
6.	 The shapes will be converted to cut paths.

Each cut path will still have the fill color that had been assigned prior to being converted into a cut path. 
This can be confirmed by selected the given cut path and inspecting the color that is shown at the far-right 
of  the SmartBar.

7.	 In the SmartBar, locate the color that was assigned to the first cut job in step (2).
8.	 Press the [ALT] key and click the given color in the Shop Palette. All colors except for the click color will 

be disabled (i.e., will appear to have a crosshatch pattern).
9.	 From the File menu, choose Print to VersaWorks.
10.	Only the cut paths with the color clicked in step (8) will be output.
11.	Once the cut job has been sent, press the [ALT] key and click the given color. All colors in the Shop 

Palette will be enabled.
12.	Repeat steps (8) through (11) for each subsequent color of  cut paths.

Tracing Cut Paths in Images

The Cut >> Contour Cut command is used to create cut paths for images (Fig. 19).

Fig. 19� - There are three ways in which to create cut paths for images.

1. Create a rectangular cut path 
around the bounding area of  the 
image.

2. Create an irregular cut path that 
traces the transition between white 
and dark portions of  the image.

3. Create an irregular cut path that 
traces the transition along a specific 
grayscale value in the image.
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1.	 Select the imported image that you want to add contour cut paths to. 
2.	 From the Cut menu, choose Contour Cut. 
3.	 At the far-left of  the SmartBar is the Bitmap frame checkbox.

To create a cut path for the rectangular bounds of  the image, set the Bitmap frame checkbox = ON.
To create a cut path that follow the contour of  the image, set the Bitmap frame checkbox = OFF.

4.	 At the far-left of  the SmartBar is the Inside/Outside checkbox. Tick this checkbox to create cut paths for 
inner contours (i.e., the inner path of  the letter ‘ O ‘ ). Otherwise, cut paths will only be created for the outer 
contours.

5.	 Set the Corner Style according to how rounded or sharp the cut paths should be.
Note: See “Adding Cut Paths to Line Art” on page 16 for more details on the contour cut path settings.

6.	 Set the Offset according to how you want the cut paths spaced along the image contours.
7.	 Select a color from the Color Picker to use for the dashed cut paths on the workspace. The color does not 

matter unless you use the Filter By Color tool, which outputs cut paths according to their color.
8.	 Click Apply to create cut paths for the image. If  the Bitmap frame checkbox = OFF, then the 

Monochrome Filter dialog will open (Fig. 20). Otherwise, proceed to step (9).
To trace the contour of  an image that has a white background, set the Threshold to 255 (move the slider all 
the way to the right).
To trace the contour of  an image that has a shadow effect, set the Threshold somewhere around 200 
(move the slider close to the right).

9.	 Click within an empty portion of  the workspace to finish editing the cut paths.

Tips When Setting the Threshold Value

The Threshold value on the Monochrome Filter dialog determines the boundary used for cut paths between 
the light and dark portions of  the image. Behind the scenes, SignLab is analyzing a monochrome (i.e. black-
and-white) version of  the image to determine the discrete boundaries of  the image. To improve the process, 
consider the following:
The image is composed of  a fine grid of  pixels. Each pixel in the image has a brightness that ranges from 0 to 
255. A brightness that is close to 0 is considered to be near white (maximum lightness), whereas a brightness 
that is close to 255 is considered to be near black (maximum darkness).
For each pixel in your image, a brightness lower than the Threshold will be considered to be white, and a 
brightness above the Threshold will be considered to be black.

Fig. 20� - The Monochrome Filter dialog is used to 
identify edges when creating cut paths for images.
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Tracing Images Using Fluid Mask
Note: Fluid Mask also has its own help documentation, and tutorial videos are available from the Fluid Mask web site ( www.
vertustech.com ).

Note: For more examples of  using FluidMask, also see the SignLab for VersaWorks Metallic Ink Design Guide.

Fluid Mask is an intuitive tool for knocking out the background of  an image, such as a photo of  a person 
standing before scenery. The process is very much like a paint-by-numbers coloring book, where you paint 
with a green brush (the Keep brush) to indicate the foreground, and paint with a red brush (the Delete brush) 
to indicate background. After the background has been knocked out, a cut path can be created around the 
foreground.
Suppose that you have a customer photo, such as a JPEG image of  their child that was taken using a digital 
camera (Fig. 21). However, the background of  the image is cluttered and needs to be clipped using Fluid Mask.

1.	 Import the image onto the SignLab workspace, select it, and then choose Image menu >> Fluid Mask.
2.	 The Fluid Mask editing mode will launch, and the image will be analyzed in order to automatically identify 

similar regions of  color and texture.
Several seconds may be required, and the resulting regions will appear much like a paint-by-numbers 
coloring book.

3.	 Along the top of  the Fluid Mask window are three tabs: Source, Workspace, and Cut-out. The 
Workspace tab should be active.

4.	 On the left-hand side is the Tools toolbar.
5.	 From the Tools toolbar, choose the Delete Local Brush tool.
6.	 With this brush, move the cursor over part of  the background image and then left-click.

Notice that regions that were overlapped by the brush have now been filled with a red mask (Fig. 22).

7.	 Continue to click other portions of  the background, such that you are filling in the background with a red 
mask (i.e., this portion is being marked for deletion).
In addition to clicking, you can also click-and-drag to paint over an area.

8.	 If  necessary, remove the tick from the Show Object Edges checkbox. This will hide the regions, such that 
you can distinguish any portions of  the background that were missed.

9.	 When you have finished painting the background red, choose Image menu >> Auto-Fill Image.
The foreground of  the image will be automatically painted green (i.e., the foreground will be kept).

Fig. 21� - From left-to-right, the original image, the image in FluidMask, and the 
finished image.



24SignLab for VersaWorks Quick Start Creating Cut Paths in SignLab

Also, a blue blending line will automatically indicate the transition region between red background and green 
foreground.
The blue blending brush is used to retain busy edges, such as hair (see Blue for busy edges).

10.	From the Tools toolbar, click the Create Cut-Out button.
11.	From the File menu, choose Save And Apply.
12.	The Fluid Mask window will close, and the view will return to SignLab.
13.	The Prime dialog will query whether a primer should be automatically applied to the image. For the sake of  

this example, choose No and click Close.
14.	The resulting image with clipped image will be placed on the SignLab workspace.
15.	To apply a cut path to the clipped image, use the Contour Cut tool.

Fig. 22� - In FluidMask, common regions are automatically identified, and the 
Delete Local Brush tool can then be used to paint away the image background.
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Color Palette Settings

Along the bottom of  the SignLab workspace is the Shop Palette. Though a default palette is set by default, other 
palettes can be set as the default, or new colors can be appended to the end of  the palette. For example, when 
a design is imported, new colors from the imported file will be appended to the end of  the Shop Palette. When 
the design is saved (i.e., Saving a CDL file via File menu >> Save), the modified palette is stored as part of  the 
design, so that the palette colors will remain consistent in future design editing.
The following sections contain typical scenarios for modifying the Shop Palette.

Setting the default palette

1.	 Go Options menu >> Palette >> Load >> Set Default, and choose the palette that should be loaded by 
default when a new workspace is created.
In the SignLab install directory, palettes are stored within the Palettes directory.

2.	 Start with a fresh SignLab workspace (i.e., File menu >> New).
3.	 The new workspace will load the default palette from step (1).

Loading a New Palette

1.	 Start with a fresh SignLab workspace (i.e., File menu >> New).
2.	 Go Options menu >> Palette >> Load >> New, and choose the palette that will be loaded for this 

workspace.
In the SignLab install directory, palettes are stored within the Palettes directory.

Appending to Shop Palette

1.	 Suppose that you already have a design, and that you want to add one-or-more colors from a color matching 
palette.

2.	 Go Options menu >> Palette >> Open Manufacturer Palette, and choose the palette that contains the 
desired colors.
In the SignLab install directory, palettes are stored within the Palettes directory.

3.	 The new palette will appear as a floating Manufacturer Palette that can be used like the regular Shop 
Palette.

4.	 Colors can be applied from the Manufacturer Palette as follows:
□□ Select a shape and then click the desired color in the Manufacturer Palette. The color will be appended 

to the Shop Palette.
□□ Drag-and-drop a Manufacturer Palette color onto the given shape. The color will be appended to the 

Shop Palette.
□□ Drag-and-drop a Manufacturer Palette color to a specific location on the Shop Palette. The color will be 

inserted within the Shop Palette.
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Merging Palettes

Suppose that you have developed a design and the Shop Palette has been customized with various colors that 
are used in the design. However, you have decided that you want to merge a new color matching palette with the 
existing palette, such that the saved CDL file will contain all the colors for future reference.
1.	 Go Options menu >> Palette >> Load >> Merge, and choose the desired palette.

In the SignLab install directory, palettes are stored within the Palettes directory.

2.	 The color from the selected palette will be appended to the Shop Palette.

Finding Specific Colors

When you know the name of  a spot color, but you are having trouble finding that color within the Shop Palette, 
then use the following procedure:
1.	 Go Options menu >> Palette >> Sort Colors >> Move Color to Front.
2.	 The Move Color to Front dialog will open.
3.	 From the drop-list, choose the spot color name.
4.	 Click OK, and the color will be moved to the far-left of  the Shop Palette.

Note that you can drag-and-drop this color to a different position.



27SignLab for VersaWorks Quick Start Color Management in SignLab

Color Management in SignLab
Note: When importing designs into SignLab, certain file types support embedded color profiles that can be used with the SignLab 
Color Management system. For more information about color profiles in files, please refer to Importing Files in the help file.

Color Management provides on-screen previewing of  your designs, such that what you see on-screen will 
approximate (as best possible for a monitor display) how the design will appear when printed. When the given 
design is printed, VersaWorks will manage the color reproduction in the finished print.
By default, the color management settings are configured when your SignLab for VersaWorks product is 
installed. However, to modify the color management settings, use the following procedure:
1.	 From the Options menu, choose SignLab Setup >> Color Management.
2.	 The Color Management dialog will open.
3.	 From the Settings drop-list, choose Custom.
4.	 Click the Advanced button.
5.	 For the Vector RGB and Image RGB drop-lists, the default of  CADlink Unified RGB.icm will be 

appropriate.
6.	 From the Printer profile drop-list, choose Browse.
7.	 A browse dialog open to the default location where VersaWorks color profiles are stored.
8.	 Choose the desired color profile and click the Open button.
9.	 The view will return to the Color Management dialog.
10.	Click the Set Defaults button.
11.	Click OK to close the Color Management dialog.

Read the Color Value of a Customer Sample

A common scenario is where the customer has provided a printed sample of  the color that they want, but the 
precise color value is unknown. It is possible to compare the sample with a swatch book provided for a given 
color matching system. Alternatively, a spectrometer or colorimeter can be used to measure the sample and 
create a new Shop Palette color.
1.	 In SignLab, choose Options menu >> Palette >> Custom Color Creator.

These palette controls are also available from the Shop Palette context menu .

2.	  The Make Custom Colors dialog will open.
3.	 To the right of  the Measure button is a drop-list. Choose the instrument that will be used for taking the 

measurement.
4.	 Check that your device is ready to measure the sample.
5.	 In the Make Custom Colors dialog, click the Measure button.
6.	 Beneath the Add button, tick the Add to Shop Palette checkbox.
7.	 Click the Add button. The Custom Palette Colors list will be updated to include the new color.

Note: All of  your custom colors are stored in a CustomColors.pal file, which is located in the SignLab \ Palettes directory.

8.	 Click Done to close the Make Custom Colors dialog. The new color will be added to the Shop Palette.
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Creating Custom Swatch Books for Your Printer

In SignLab, swatches can be created of  the Shop Palette colors. In this manner, you can print your own swatch 
books that are specific to your loaded inks and media, and create a full range of  swatches for specialty or banner 
material.
1.	 Start with a fresh SignLab workspace (i.e., File menu >> New).
2.	 Go Options menu >> Palette >> Load >> New, and choose the palette for which swatches will be 

created.
3.	 Go Options menu >> Palette >> Create Palette Swatch.
4.	 Swatches for the current Shop Palette colors will be generated on the workspace.

The swatches can now be printed and bound as a color reference for your printer.

Create Process Color Swatches for RGB Printing

Under the File menu, the Color Swatches feature can create standard process color swatches for RGB, CMY, 
or CMYK color values. An easy means of  color matching is to print a set of  RGB swatches that are specific 
to the media and inks that are loaded into your printer. These printed swatches can then be stored in a binder 
for use as a reference when helping the customer to identify the hue that they need. For example, the following 
procedure shows how to create swatches for RGB.
1.	 From the File menu, choose Color Swatches to open the Color Swatches dialog.
2.	 Click the Standard option.
3.	 Click the RGB option.
4.	 Click OK to continue.
5.	 A series of  swatches will appear on the workspace.

The speed with which these swatches are generated depends on the speed of  your workstation.

The swatches can now be printed and bound as a color reference for your printer. As in the above procedure, it 
is also possible to create CMY and CMYK color swatches.

□□ The standard CMYK swatches are similar to the CMY swatches, except that Black is added as a fourth 
colorant. 

□□ Each swatch is quartered, with 5% black in the top-left, 10% black in the top-right, 20% black in the 
bottom-left, and 30% in the bottom-right of  each swatch.
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Image Preparation in SignLab

In the event that your customer has provided less than adequate artwork, the image processing tools in SignLab 
can be used to restore the artwork to a professional level for large format printing. Image processing tools are 
located under the SignLab Image menu. For more information within this help file, please refer to the Working 
with Images chapter for descriptions of  the image processing tools that are available. In particular:

□□ The Super Size Image tool is used to restore quality to low-resolution images, providing significant quality 
improvements over that of  bicubic resampling.

□□ The Fluid Mask tool is an intuitive tool for knocking out the background of  an image, such as a photo of  a 
person standing before scenery.
FluidMask is used extensively in metallic ink preparations (See the SignLab for VersaWorks Metallic Ink Design 
Guide).

□□ Color Adjustment Tools provide advanced levels, curves, hue/saturation, etc. controls for performing 
specific improvements to a given image.

□□ Easy Color Adjustments provide quick filters for cleaning up images.
□□ Image Menu Filters provide a selection of  effects that can be applied to images.
□□ Plug-ins support for both Adobe and third-party plug-ins, with included plug-ins from the Richard 

Rosenman, Redfield, Harry, Alien Skin, and CADlink collections.
□□ Superior image tracing capability using the Prepare to Vectorize Wizard.
□□ The GIMP image manipulation interface that provides professional tools for photo retouching, image 

composition, and image construction that are similar to PhotoShop in the effects that can be created.
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